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Problem Formulation and Background 
I went into this project really wanting to produce something that had not 

been thought of or created before.  I therefore began looking at examples hoping to 

spark my imagination and thought process.  Unfortunately, it took unclipping from 

my binding like pedals on my mountain bike and tumbling down a set of natural 

limestone stairs on the main loop at City Park mountain bike trail for an idea to be 

conceived.  I am an avid cross country and aggressive downhill mountain bike 

rider when not working or studying and it seemed only logical to do something on 

the sport I sweat, breath, bleed and love.  So, lying dazed on my back, I closed my 

eyes and cursed, “I got it”.  In the time it took for me to get up and remove my full 

face helmet I had a plan.   

I want to have a trail map of City Park, showing elevation, technical 

difficulty and slope gradient, not to mention the general route and distance of the 

trail.  My goal is to create a ski resort like map with a few additions and omissions.  

To accomplish this I will utilize handheld GPS receivers as well as ESRI’s ArcGIS 

platform.   

Another goal of this project is to identify the demographics of the riders.  

Since this is one of, if not the most technical and fast paced single track mountain 

bike trails in Texas, I am intrigued by the notion I may be one of the few young 

riders of this trail.  To attain this human data I will observe and talk to other riders 
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I met on the trail or in passing in the parking lot.  I also ride with a group of 

friends, all of whom are in their thirties.  I have asked them to do the same thing 

when they ride on their own.  The data I will gather includes rider age and gender, 

as well as the riders’ suspension set up (full or front suspension) and wheel base 

(26 or 29 inch wheel size).   

Data Collection 

 GIS data 

 The data I have collected for this project includes: GPS data points of the 

mountain bike trail with a total of 589 points, six emergency entrance trails totaling 

to 91 GPS points, and 29 GPS points defining a section of trail closed to riders due 

to illegal clearing.  At first I was using a Trimble handheld receiver with ArcPad, 

hoping that by utilizing this advanced piece of technology I would be able to jump-

start my ArcMap project.  However, using the unit in dense growing cedar trees 

proved to be quite a challenge for the unit.  The next GPS unit used was a Garmin 

60CSx and produced fantastic results.  The Garmin is much lighter and compact 

when compared to the expensive and cumbersome Trimble.  It also has an exposed 

antenna, which enabled me to traverse my ride with the unit securely inside of my 

hydration pack.  Using the 60CSx isn’t as complicated as the Trimble receiver 

either.  As capturing GPS data is only a few manipulations of the menu away.  To 

start collecting a continuous track of data, the Track Log must be cleared in the 

Tracks tab of the menu.  Next, one must turn the Track Log on in order for the unit 
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to begin taking data.  The record method (Auto, Time or Distance) and the interval 

type (most often, more often, normal, less often or least often) can be altered in the 

setup subset of the Tracks tab.  The Garmin enables user freedom in specifying 

amount and how the unit calculates a route, while retaining the precision and 

accuracy that the Trimble would produce.   

To add a comparison to my GPS results, I found a GPS trail map done by a 

rider in 2005.   The image (http://www.austinbike.com/mtb/citypark/index.asp), a Google Earth 

snapshot shows a faint red line representing the mountain bike trail.  By 

georeferencing this image I will be able to display my track on top of it to see how 

the accuracies compare.         

From the USGS’s seamless server, (http://seamless.usgs.gov/website/seamless/viewer.htm) 

I downloaded a 1/3 arc second NED Shaded Relief DEM, a shapefile of Bureau of 

Transportation Statistics Roads, Color Orthoimagery of the study area (Austin .5ft) 

and a water features shapefile.  Unfortunately for my study, the USGS does not 

have a 1/9
th

 arc second map of the area around the City Park Mountain Bike Trail. 

The 1/9
th

 arc second map has a higher resolution of 3 meters instead of the 1/3
rd

’s 

10 meter resolution.  In order to download data, follow the above URL to the 

USGS’s website and use the zoom tool to enlarge an area of interest.  Browse the 

available data by expanding the categories to the right of the page; check the boxes 

which apply to your study.  In the Downloads toolset choose “define rectangular 

http://www.austinbike.com/mtb/citypark/index.asp
http://seamless.usgs.gov/website/seamless/viewer.htm
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download area” and simply drag the tool across the area of interest.  Make sure you 

have any pop up blockers disabled to insure that a download window appears.  

Click download on each specific file and choose the appropriate file location.  Be 

aware that this process may take quite some time, especially with large study areas.  

 
 

Statistical Human Data 

 As stated earlier, I had a goal of attaining rider data for City Park Mountain 

Bike Trail to see where I fall in the distribution.  I am 22 years of age and ride a 26 

inch full suspension mountain bike.  From October 2
nd

, 2010 up until November 

27
th
, 2010 I rode City Park a total of 26 times.  On some days, the parking lot at the 

start of the trail would be empty and on other days there could be five or six cars.   

On 16 of these rides, I collected information on rider gender, age and rig setup.   

Human Data Results 

My population size for the study was 45 riders.  

Of these riders, only 3 were female. The three 

women were all in the age range of 25 to 30 
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years old.  These women all rode on the same general type of bike set up, 26 inch 

wheel size with full suspensions.  For the male riders of this trail there is much 

more variance in the results.  30 of the of the 42 male riders ride a 26 inch 

mountain bike and of these 30, 24 of them have full suspensions.  As I suspected, 

the majority of the riders of this trail are in fact older than I am.  This could be due 

to the fact that the mountain bike trail 

at City Park is one of the most 

challenging in the region.  One can 

infer that to tackle such a demanding 

and strenuous trail requires experience 

and repetition, which are directly 

correlated to age.  Another correlation linked to age is wealth.  The bikes ridden at 

City Park can range in price from (my first true mountain bike) 1,500 dollar entry 

level full suspension bikes to the other end of the spectrum, 6,500 - 9,000 dollar 

carbon fiber and technology heavy wonders.  Also, limestone isn’t friendly to bikes 

or the rider, so when you fall you could be looking at a cracked frame, shattered 

handle bars, leaking suspensions, warped oval wheels.  The same risk also applies 

to the rider; hospital bills can be immense.  A ride at City Park can essentially cost 

hundreds of dollars at a time, as well as blood, stitches and casts.          
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Excel spreadsheet of sample data collected from October 2
nd

 – November 27
th

. 

Date Rider Number Female Male Age 18-25 Age 25-30 Age 30-40 Age 40+ Full Suspension Front Suspension 26 inch wheel 29 inch wheel

100210 1 0 1 0 0 1 0 1 0 0 1

100210 2 0 1 0 0 1 0 1 0 1 0

100210 3 0 1 0 1 0 0 1 0 1 0

100510 4 0 1 0 0 1 0 1 0 1 0

100710 5 0 1 1 0 0 0 0 1 0 1

100710 6 1 0 0 1 0 0 1 0 1 0

100910 7 0 1 0 0 0 0 1 0 1 0

100910 8 0 1 0 0 0 0 1 0 1 0

100910 9 0 1 0 0 0 0 1 0 1 0

100910 10 0 1 0 0 0 0 1 0 1 0

100910 11 0 1 1 0 0 0 1 0 0 1

101010 12 0 1 0 0 1 0 1 0 1 0

101610 13 0 1 0 0 1 0 0 1 1 0

101610 14 0 1 0 0 1 0 1 0 1 0

101610 15 0 1 1 0 0 0 1 0 1 0

101610 16 0 1 0 1 0 0 1 0 1 0

101610 17 0 1 0 0 0 1 1 0 0 1

101610 18 1 0 0 1 0 0 1 0 1 0

101910 19 0 1 0 1 0 0 1 0 1 0

101910 20 0 1 0 0 1 0 1 0 1 0

101910 21 0 1 0 0 1 0 1 0 1 0

102210 22 0 1 0 0 1 0 1 0 1 0

102410 23 0 1 1 0 0 0 0 1 0 1

102410 24 0 1 0 0 1 0 1 0 0 1

102810 25 0 1 1 0 0 0 1 0 0 1

102810 26 0 1 0 0 1 0 0 1 1 0

102810 27 0 1 0 0 1 0 1 0 0 1

102810 28 0 1 0 1 0 0 1 0 0 1

102810 29 0 1 0 1 0 0 1 0 1 0

102810 30 1 0 0 1 0 0 1 0 1 0

110110 31 0 1 0 1 0 0 0 1 1 0

110110 32 0 1 0 0 1 0 1 0 0 1

110110 33 0 1 0 1 0 0 1 0 1 0

110410 34 0 1 0 1 0 0 1 0 0 1

110410 35 0 1 0 1 0 0 1 0 1 0

110410 36 0 1 0 0 1 0 1 0 0 1

110710 37 0 1 0 0 1 0 1 0 1 0

110710 38 0 1 0 0 0 1 1 0 1 0

111010 39 0 1 1 0 0 0 1 0 1 0

111310 40 0 1 1 0 0 0 1 0 1 0

111310 41 0 1 0 1 0 0 1 0 1 0

111310 42 0 1 0 0 1 0 0 1 1 0

112010 43 0 1 0 1 0 0 1 0 1 0

112010 44 0 1 0 1 0 0 0 1 1 0

112710 45 0 1 0 1 0 0 1 0 1 0

Totals 3 42 7 16 16 2 38 7 33 12



A GIS Analysis of City Park Emma Long Single Track Mountain Bike Trail                                                    
By: Trevor J. Hutton 
 

Page | 8  
 

Data Processing With ArcGIS 

1. Extracting GPS data 

a. Connect the Garmin 60CSx to computer via universal serial 

bus 

b. Run DNRGarmin 

c. Select a projection  

d. For the Study area of Austin, use NAD83 UTM Zone 14 

e. Since the data was collected as tracks click               

Track>Download Track 

2. Bringing the Track Data into ArcMap 

a. Open ESRI ArcMap and create open a blank map. 

b. To display our GPS track points click                         

Tools>Add XY Data  

c. Browse to the .txt and select X_PROJ for the X Field and 

Y_PROJ for the Y Field. Also choose a coordinate system by 

clicking 

Edit>Select>Projected Coordinate System>UTM>NAD 1983 

UTM Zone 14N 
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d. Click Ok. You should receive a warning message stating that 

you will be unable to perform queries on the data. Say yes and 

you should get something like the following.  

 

3. Creating a continuous polyline using XTools 

a.  

b. Make sure you have the extensions for XTools and 3D Analyst 

enabled.  Tools>Extensions  
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c. Open the XTools dropdown menu and select                   

Feature Conversions>Make One Polyline From Points 

d. Make sure the correct event is selected and specify a name for 

the resultant polyline 

e. Next we must Define a Projection for the polyline, as it will not 

display, unprojected.  In Arc Tool box, expand Data 

Management Tools>expand Projections and Transformations 

and double click Define Projection.   

f. Set input Dataset to the Polyline 

and Select 

NAD_1983_UTM_Zone_14N as 

the Coordinate System.    

g. Your resulting display should 

appear as follows.  
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4. Extracting elevation from the DEM to the mountain bike trail track. 

a. Add the DEM by clicking the add data button.  

b. Notice the default color bar, with bright white as the high and 

dark black as the low.  We will manipulate the symbology later 

to better depict the terrain.   

c. Next, we wish to create a route showing only the elevation from 

the DEM. 

d. Open the Spatial Analyst Toolset and expand extraction. Select 

Extract by Mask. 

e. Click Ok.  

f. Now we have a raster track showing the high and low points of 

the trail. 
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g. To take this idea further, we need to add correct elevations in 

meters to our emma_tracks.txt event.  This will allow us to 

create a profile of the trail later.  In the same toolset under 

Extraction double click Extract Values to Points. This overlay 

method will add a new column to the attribute table.   

 

 

h. Click Ok and view the modified attribute table, the new 

column is named RASTERVALU  
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5. Add M value (measurement from start of track in meters) to the GPS 

track with the elevation values. 

a. Linear Referencing Tools>Create Routes 

 
b. As in step 4g, extract the values of the new track to points.  

View the newly created attribute table. 

 
i. Now there is a measurement column in the attribute 

table showing a distance in meters from the specified 

start of the track.   

6. Export GPS points to Excel to create track profile 
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a. In XTools drop down menu select Table Operation> Export 

Data to MS Excel. 

b. Select only the RID, MEAS and RASTERVAlU fields. 

 

 

c. Click OK, XTools will automatically open Excel. 

d. In Excel we will make a X Y Chart from the Charts menu on        

     the Insert Ribbon.  Our raster values are elevation and the  

     measurement values are meters from the start of the mountain   

     bike trail. 

e. Unfortunately, the Linear Referencing tool used to add 

measured values did not give much adjustment in defining the 

start and end of the track.  Manipulate the table by looking at 

the unique number in the ArcMap Attribute table to correlate 

a true starting point in Excel for the track.  Once the start is 

defined, it requires a tedious process of adding and subtracting 

meter values from the exported distance from ArcMap. 

f. Once completed, create a chart plotting distance verses 

elevation. 

g. This chart shows the elevation change across the entire length  

     of the trail.  Vertical exaggeration equals 28.6. 
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7. Add aerial photo, streams and roads to the ArcMap project.   

a. File>Add Data 

b. Navigate to the file locations of the Orthoimagery, streams and 

roads shape files downloaded from the USGS’s website. 

 

 
 

8. Adding tracks of 6 EMS entry points as well as one closed trail track 

a. Again, using DNRGarmin, download the closed track from 

your handheld GPS unit. 

b. Save as text file and add to your ArcMap project by selecting 

add x/y data in the tools drop down menu.  Make sure you 

choose the appropriate fields. 

c. In the table of contents right click the added “event” and 

choose Data>export data. 

d. Remove the event and make sure you have the XTools 

extension turned on, because we need to make these GPS 

points into a polyline. Refer to step 3. Remove the point data 

file. Symbolize the closed track appropriately.  

e. For the EMS tracks, repeat steps a-d but do not remove the 

GPS point file as this will come in handy in editing the line. 
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f. You should get a polyline similar to this (green line is the 

imported EMS trails, dotted red line is the closed trail track). 

 
g. We need to edit this polyline so it becomes six unrelated 

segments. Turn on the editor tool bar and select start editing, 

choose the appropriate database to manipulate.   

h. Next, set Task to “Extend/Trim Features” and set your EMS 

track as your Target to modify. Click the track and then 

activate the “split tool” located next to the Target drop down 

menu in the Editor Tool Bar.   

i. Split the polyline around the six point maximums. 

 
j. Save edits and stop editing.  
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9.  Creating a slope map and a hill shade map from our DEM. 

a. Activate the DEM and right click it in the table of contents and 

choose properties.  Navigate to the Source tab.  Notice that the 

Spatial Reference is not projected.  We need to project it into 

UTM Meters.  

i. To convert the raster to UTM projected coordinates 

open the Data Management Toolset and expand 

Projections and Transformations, expand Raster and 

double click “Project Raster”. 

ii. Select the DEM as the Input Raster and set the Output 

Coordinate System to “NAD 1983 UTM Zone 14N” 

b. Now we are ready to make a slope map of our study area.  On 

the 3D Analyst Toolbar select Surface Analysis> Slope.  For 

Input surface select the DEM and keep the default settings.  
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Make sure to specify a file location or ArcMap will simply put 

the map in a temporary folder.         

 
i. Now we have a slope map of the area around the City 

Park Mountain Bike Trail.  

                     
c. Again use the Surface Analysis tool in the 3D Analyst Toolset.  

Select Hill shade. 
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d. The resulting map should look something like this. 

                         
11.   Using the slope map to create a raster track of the mountain bike 

trail. 

e. Open the Spatial Analyst Toolset and expand extraction. Select 

Extract by Mask. 

i. For the Input raster choose the slope map. Select the 

GPS track of the mountain bike trail as the feature mask 

data.  This will define the area to be extracted from the 

DEM. 

ii. The resulting raster will show the slope change across 

the mountain bike trail.   
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10.  Creating a Contour Map from the DEM. 

a. First, clip the DEM to the aerial photo. 

i. Data Management Toolset>Raster>Raster 

Processing>Clip 

   
ii. Remove the un-clipped DEM from the Table of 

Contents. 

b. Turn on the 3D Analyst Toolset and on the menu bar click the 

down arrow next to 3D Analyst.  Choose Surface Analysis> 

Contour.  Also make sure that you have the Target Layer set to 

your clipped DEM. 

i. Make you interval 10 and z factor 1 and designate a 

proper output destination             

 
ii. Click Ok  
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iii. Your resulting Contour shapefile should look something 

like this.  Contour intervals are in meters.        

 
iv. Next we should apply contour labels.  Right click the 

layer in the table of contents and choose properties.  

Select the Labels tab.  For text string drop down menu, 

choose CONTOUR and symbolize the labels 

appropriately.  Check the box next to Label features in 

this layer. 
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v. Click Ok.                                                        

 
11.   Georeferencing the Google Earth image with the GPS data collected 

in the field. 

a. This task will allow comparisons to be made between the 

collected GPS data points and the trail map found online. 

b. To capture the image from the web, press print screen and 

paste the screen capture into MS PowerPoint.   

i. Crop the image 

ii. Save image as .jpeg 

c. Add the .jpeg to project 

i. Data management tools>define projection  

1. GCS NAD1983 

ii. Data management tools>Raster>project raster 

1. PCS UTM NAD1983 zone 14N 

iii. On the Georeferencing Toolbar select the .jpeg as the 

target layer. 

1. Zoom to layer 

d. Now, set four to five control points at locations that are obvious 

in both the .jpeg and the aerial photo.   

i. GPS field data in green, georeferenced 

photo with red trail. 

  

 



A GIS Analysis of City Park Emma Long Single Track Mountain Bike Trail                                                    
By: Trevor J. Hutton 
 

Page | 23  
 

Resulting images and maps created 

1. The following maps show the main loop, emergency trail entrances, 

closed route, streams, roads and contours.   

a. Hill Shade Map (calculated using default hillshade settings of 315 

degree azimuth and a 45 degree altitude of slope from the sun).                                                                           

 
b. Slope Map (degrees of slope).                                                                  
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c. Digital Elevation Map (meters).                                            

   
d. Geologic Map Units of The Glen Rose Formation.                                                         
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e. Aerial Photo of City Park Mountain Bike Trail. 

 
2. Elevation Map Masked to the Main Loop (Elevation in Meters)            
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3. Slope Map Masked to the Main Loop (Slope in Degrees) 

  
4. ArcScene Screenshots  

a. ArcScene allows the user to display ArcMap projects in three 

dimensions.   

i. To do so, add your data to a new project in ArcScene. 

ii.  Next you must set your base heights and vertical 

exaggeration for the Data Frame.   

iii. Right click Scene Layers and select Scene Properties.  From 

the General Tab click calculate from extent (Vertical 

Exaggeration).  The calculated exaggeration for my 

ArcScene project based on my data is 3.68023e-00 which 

equals 3.68023.                    
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iv. Next set the base heights for each layer in the table of 

contents.  Right click>Properties>Base Heights Tab.  We 

want to obtain our heights from our DEM so select “Obtain 

heights for layer from surface:” in the drop down, select the 

DEM.  Repeat this for each of the layers. 

v. To make things display clearer, adjust the transparency of 

the Surfaces.   

b. Slope Map Masked to the Main Loop.

 
c. Main Loop on the DEM.

 
i. Low elevation of the region is Lake Austin with an elevation 

of 147 meters and the high elevation of the area is 298 

meters.  Vertical Exaggeration equals 3.68023. 
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d. Main Loop on Clipped Slope Map and DEM. 

 
e. Main Loop on Slope Map. 

 
i. Fantasy Downhill trail with tough vertical climbs? 
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1. Line feature digitized in ArcMap and added to 

ArcScene.  Using the “create steepest path tool” in the 

3D Analyst Toolset, I created line segments showing 

the steepest path down from a point.  These lines were 

then merged into a polyline using XTools.  I used this 

method for about 25 percent of the above black trail. 

The other three quarters I inferred using my own 

understanding of how the mountain bike trails follow 

topology best and the contours created from the 

DEM.  These two sets of polylines were merged using 

features in the editor toolbar. 

5. Georeferenced .jpeg to main loop GPS data.  
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Conclusion 

The City Park Mountain Biking Trail is a very technical ride, as is evidenced 

by the elevation change and slop gradient. There is a section of low elevation of 

roughly 210 meters near the start and towards the end of the loop. A maximum 

elevation is reached in peaks, 4.5 to 6 kilometers from the start of the trail. This 

maximum elevation ranges from 255 to 260 meters. The average climb and 

downhill section covers no more than 20 meters of elevation change. These 

sections also have the greatest slope gradient, which varies from 20 to 50 degrees. 

The total length of the Trail from start to finish is 9,247 meters, but seems like a lot 

longer because of the total elevation gain of 266 meters over the course of the trail. 

Statistically speaking, mainly men in their late twenties to late thirties ride this 

trail.  This is most likely due to the fact that mountain as a hobby or sport is 

expensive, and can be costly in upkeep and maintenance.  Limitations to my survey 

are the fact that I choose the most aggressive and least ridden trail in Texas, 

causing my population sample size to be only 45 people.  Also, I only rode after 

class or on the weekends, and would only be on the trail for about an hour and a 

half.  There were clearly more riders on the trail that I wasn’t able to observe or 

survey due to my restricted schedule. Errors in my GPS data are minimal and 

should be no more than three to give meters off of the actual trail.  The elevation 

data from the GPS can be off by upwards of 20 meters.  So, instead the elevation 

from the digital elevation map (DEM) was used in all elevation calculations in this 
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study.  Despite the limitations and sources of error, I was able to use GIS and GIS 

applications to produce a useful trail map of City Park Mountain Bike Trail.  The 

data and map synthesized many physical aspects of the trail and will be useful to 

any rider attempting to conquer this difficult ride. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


